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6GEI300 - Électronique I 

 
Laboratoire #4 

 
Introduction aux PCBs 

 
Automne 2011 

 
 

1. Objectifs 
 

• Explorer la conception de PCBs 
• Explorer le concept des footprints 
• Concrétiser les notions sur les circuits à diodes 

 
2. Méthodologie 
 
Dans ce laboratoire, vous aurez à concevoir des PCBs simples contenant des résistances, 
condensateurs, boutons poussoir et LEDs (diodes électroluminescentes). Dans la 
première partie du laboratoire, il sera question de suivre un tutoriel pour créer un circuit 
avec une résistance et une LED qui est alimenté par une tension externe. Par la suite, 
vous apprendrez à dessiner un footprint et à l’inclure dans votre circuit pour avoir un 
système complet. Finalement, vous aurez à construire un circuit du début jusqu’à la fin de 
façon autonome. 
 

3. Travail demandé 
 
Section 1. Tutoriel 
 

a) Schéma 
 
Contrairement aux autres laboratoires, celui-ci demande qu’on créée un nouveau projet et 
pas juste un schéma. La différence est que, dans un projet, il y a un certain lien qui existe 
entre les différents fichiers. Il y a plusieurs types de projets dans Altium. Celui qui va 
nous intéresser c’est le projet de type PCB (« printed circuit board », ou circuit imprimé). 
Pour créer un projet, sélectionnez New → Project → PCB Project (Figure 1). 
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Figure 1. 

 
Maintenant que le projet a été créé, on va ajouter 2 fichiers (ne faites rien encore): un 
schéma électrique et un dessin de circuit imprimé (dessin physique avec des polygones). 
La création d’un schéma électrique ressemble beaucoup à ce qui a été fait jusqu’à présent 
dans les laboratoires en electronique 1. C’est un dessin qui est conceptuel et qui montre 
comment les éléments sont reliés entre eux. Il n’y a cependant aucune information 
physique concernant leurs dimensions et leurs emplacements. Le dessin du circuit 
imprimé, lui, contiendra l’information sur où les composantes doivent être placées et 
comment elles sont reliées entre elles. 
 
Commençons par ajouter le schéma électrique. Pour ce faire, déplacez votre souris à 
gauche et mettez-la sur le nom de votre projet (qui s’appelle PCB_Project1.PrjPCB par 
défaut). Cliquez dessus avec le bouton de droite et selectionnez Add New to Project → 
Schematic (Figure 2). Une fenêtre vide devrait apparaitre : c’est la fenêtre dans laquelle 
nous sommes habitués de dessiner nos circuits. 
 

  
Figure 2. 

 
Pour cette première partie, nous allons vouloir faire le circuit de la Figure 3 pour 
apprendre la procedure. C’est un circuit avec une résistance et une LED : lorsque le 
signal en entrée a une tension assez elevée, le courant devrait circuler et la LED devrait 
s’allumer.  
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Figure 3. 

 
La procédure pour dessiner ce circuit est semblable aux autres laboratoires. Cependant, 
cette fois-ci, il faut faire attention de choisir des composantes qui existent et qui sont 
disponibles au laboratoire du DSA. Par exemple, il existe des résistances de différentes 
valeurs, de différentes dimensions, certaines ont des pattes tandis que d’autres n’en ont 
pas, etc. Ces caractéristiques sont déterminés par le boitier (« package ») dans lequel se 
trouve la résistance et ce boitier détermine aussi comment représenter la résistance sur un 
circuit imprimé. La Figure 4 présente  des exemples de boitiers qui seront utilisés au 
laboratoire 4 et 5. 

 
Figure 4. 

 
La résistance que nous voudrons utiliser dans ce laboratoire est une résistance avec un 
boitier de type AXIAL-0.3. Ceci veut dire qu’il ressemblera au dessin au milieu de la 
Figure 4 et les fils des pattes sont séparés par 0.3 pouce (Figure 5). 

 
Figure 4. 

 
Ouvrez la fenêtre pour ajouter une résistance de type RES1 et regardez en bas de la 
fenêtre (Figure 5): nous voyons le nom du boitier à gauche et, à droite, nous voyons à peu 
près ce que Altium mettra sur le circuit imprimé pour accommoder la résistance 
(« footprint »). Ce footprint indique qu’il y a deux trous de part et d’autre d’un rectangle : 
chaque trou accueillera une patte de la résistance et le rectangle n’est là que pour 
identifier l’objet à placer à cet endroit.  
 
Sélectionnez cette résistance RES1 et placez-la dans le circuit. Pour le dessin des PCBs, 
les valeurs des composantes n’ont aucun effet sur le résultat final. Cependant, c’est 
toujours une bonne pratique de mettre les vraies valeurs de composantes dans le schéma. 
Dans ce cas-ci, imaginons que la valeur de la résistance est de 1K. 

1K

r1

Res1

d1
LED0

GND

entree
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Figure 5. 

 
La prochaine étape est de placer la LED. La LED se trouve dans la même librairie que la 
résistance. En ce qui concerne son footprint, il peut soit être de type LED-0 ou de type 
LED-1. Nous allons donc utiliser la composante qui a ce footprint. 

 
En regardant dans la liste, nous voyons que la composante LED0 a le footprint de type 
LED0 (Figure 6). Nous le selectionnons et nous le plaçons dans le circuit. 

 
Figure 6. 

 
Terminez le dessin du circuit en ajoutant la masse et en mettant un fil avec le nom entree. 
À la place de mettre des sources de tension comme dans les autres laboratoires, nous 
mettons des fils qui portent des noms. Ceci nous indiquera qu’il y a une certaine 
connection avec le monde EN DEHORS de notre circuit. Dans notre cas, effectivement, 
nous voulons pouvoir connecter un signal en entrée en passant par le fil entree. Il y a 
aussi une 2e connexion vers le monde extérieur qui est implicite dans notre cas : c’est la 
masse.  

 
Une fois que vous aurez fini de dessiner le circuit de la Figure 3, sauvegardez. 
 
 

b) Circuit imprimé 
 
Il est maintenant temps de passer au dessin physique. Pour ce faire, commencez par 
ajouter un nouveau fichier PCB au projet. Ceci se fait en cliquant sur le projet avec votre 
bouton de droite et en selectionnant Add New to Project → PCB (Figure 7). 
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Figure 7. 

 
Vous devriez obtenir un ecran noir tel que montré à la Figure 8. 

 
Figure 8. 

 
La prochaine étape est de dire a l’outil que nous avons déjà un schéma et qu’il devrait 
nous donner les composantes qui sont présentes dans le schéma. Pour ce faire, il faut 
commencer par sauvegarder le fichier PCB (oui, même si c’est vide). 
 
Une fois sauvegardé, allez dans Design → Import Changes from PCB_Project1.PrjPCB 
(Figure 9). 

 
Figure 9. 
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Une fenetre SEMBLABLE à celle de la figure 10 devrait apparaitre. Nous n’allons pas 
nous préoccuper de cette fenêtre pour l’instant. Cliquez simplement sur Execute Changes 
en bas à gauche de la fenêtre.  
 

 
Figure 10. 

 
Des coches vertes devraient apparaitre à droite de la fenêtre pour nous dire que tout 
fonctionne. Si vous voyez des X rouges, appelez le chargé de laboratoire. 
 

 
Figure 11. 

 
Vous pouvez maintenant fermer cette fenêtre en cliquant sur CLOSE en bas à droite. En 
regardant la fenêtre principale, vous devriez voir qu’il y a des composantes en bas a 
droite (encadré en rouge à la Figure 12). Vous devriez retrouver une LED et une 
résistance. 
 

 
Figure 12. 

 
Amenez vos deux composantes en quelque part dans la fenêtre. En temps normal, vous 
devriez tenter de placer vos éléments pour que ça prenne le moins de place tout en 
faciliant la connexion entre votre composantes. Pour les buts de cet exercice, et pour ce 
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circuit si simple, ne passez pas plus qu’une minute à le faire. Notez qu’en déplacant les 
composantes, il est possible de les faire tourner (rotation) en pesant sur la barre 
d’espacement. Le résultat pourrait ressembler à la Figure 13. 

 
Figure 13. 

 
Vous devriez remarquer qu’il y a une ligne blanche mince qui semble connecter une patte 
de votre résistance a une patte de votre LED. Ceci indique qu’il devrait y avoir une 
connexion entre ces pattes et cette information provient directement de votre schéma. 

 
Nous pouvons maintenant commencer à dessiner les connexions entre les pièces. 
Commençons justement par cette connexion. Pour tracer une connexion, cliquez sur le 
symbole en haut de la fenêtre tel qu’indiqué à la Figure 14 (Interactively Route 
Connections). 
 

 
Figure 14. 

 
Cliquez maintenant sur la patte de la resistance avec votre bouton de gauche pour 
commencer à dessiner la connexion. Quand c’est fait, vous devriez voir un fil se déplacer 
avec votre souris. Déplacez maintenant votre souris vers la patte de la LED et cliquez. 
Quand c’est fait, la connexion devrait être faite mais il devrait encore avoir un fil qui 
vous suit lorsque vous déplacez votre souris. Pour que ça arrete, il faut peser sur ESC. 
 
Le résultat pourrait ressembler à la Figure 15 : 

 
Figure 15. 

 
Bien que ce circuit puisse sembler complet, il comporte certains problèmes. Par exemple, 
nous n’avons présentement aucune manière de venir se connecter au circuit : il n’y a pas 
de place pour injecter un signal en entrée ni de place pour se connecter a la masse.  
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Pour régler ce problème, nous allons ajouter 2 plots (PADS) où nous allons venir souder 
des fils ou des contacts. Pour les ajouter, cliquez sur le bouton en haut de la fenêtre tel 
que montré à la Figure 16. 
 

 
Figure 16. 

 
Allez placer ces 2 plots « proches » des endroits appropriés (Figure 17). Un plot devrait 
être proche de la patte non-connectée de la LED (GND) et l’autre plot devrait être proche 
de la patte non-connectée de la résistance (entree). 
 

 
Figure 17. 

 
Pour que Altium nous permette de connecter les plots au circuit existent, il faut que ces 
plots aient le même nom que les autres composantes dans le circuit. Par exemple, le plot 
qui est utilisé pour le signal entree devrait lui aussi s’appeler entree. De façon semblable, 
le plot pour la masse devrait s’appeler GND. Pour ce faire, nous allons double cliquer sur 
le plot de droite en premier (pour la masse). La fenêtre de la Figure 18 devrait apparaitre. 

 
Figure 18. 

 
Dans la section intitulée NET, selectionnez GND. Quand c’est fait et que vous avez pesé 
sur OK, vous devriez revoir votre schéma. Cette fois-ci, cependant, il devrait y avoir une 
ligne mince qui relie ce plot à une patte de la LED. Ça indique que Altium comprend 
qu’il doit y avoir une connexion. 
 
Repetez ces étapes avec l’autre plot : le plot de gauche devrait s’appeler entree. Lorsque 
tout est complété, votre diagramme pourrait ressembler à la Figure 19. 
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Figure 19. 
 

Utilisez la méthode décrite précedemment pour faire les connexions entre les plots et le 
reste du circuit. Le résultat pourrait ressembler à la Figure 20. 
 

 
Figure 20. 

 
Le circuit imprimé pourrait déjà être considéré comme étant complet. Cependant, nous 
allons vouloir ajouter un « plan de masse » (ou « ground plane »). Un plan de masse est 
une structure métallique qui couvre la presque totalité de la plaque et qui est connectée à 
la masse. Les plans de masse offrent plusieurs avantages incluant un blindage contre le 
bruit, une masse moins inductive et aussi moins résistive.  
 
Pour créer un plan de masse, cliquez sur le symbole presenté à la figure 21 (Place 
Polygon Pour). 

 
Figure 21. 

 
Une fenêtre semblable à celle de la Figure 22 devrait apparaitre. Concentrons-nous sur la 
section encadrée. Il faut indiquer à Altium que nous voulons que le plan de masse soit 
connecté à la masse. Sélectionnez GND et cliquez sur OK. 
 

 
Figure 22. 

 
Vous pouvez maintenant dessiner votre plan de masse. Pour ce faire, dessinez un 
quadrilatère qui englobe votre circuit un peu comme ce qu’on voit à la Figure 23. Il est à 
noter que vous n’avez besoin que de sélectionner la région extérieure : Altium 
s’arrangera pour ne pas causer de court-circuits avec les autres nœuds. Une façon de 
procéder pourrait être de commencer par cliquer en haut à gauche, ensuite de cliquer en 
haut à droite, en bas à droite et finalement en bas à gauche. Quand vous avez fini votre 
dernier clic, vous pouvez peser sur ESC. Votre circuit pourrait ressembler à la Figure 23. 
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Figure 23. 

 
Section 2. Footprints 
 
a) Footprints disponibles 
 
Dans la conception des PCBs en électronique 1, lorsqu’il est possible, il est suggéré 
d’utiliser les composantes dont on possède les footprints. Dans le cas des composantes 
standards, tels que les résistances, condensateurs et LEDs, ces footprints sont presque 
toujours disponibles. Il faut cependant savoir où les trouver. 
 
Retournons au schéma. Imaginons que nous voulons utiliser une capacité de 10µF et que 
la composante disponible au laboratoire avait un footprint de type AXIAL-0.9. Passez 1 
ou 2 minutes (pas plus !) à essayer de voir si vous êtes capables de le trouver. En 
regardant dans la liste d’éléments conventionnels, vous ne devriez pas être capables de 
trouver une capacité qui a ce footprint. 
 
Pour règler ce problème, commencez par choisir la capacité de type CAP et insérez-la 
dans votre circuit (n’importe où, puisque nous ne faisons que des tests). Une fois placé, 
double-cliquez votre condensateur. Une fenêtre comme celle de la Figure 24 devrait 
apparaitre. Cliquez sur RAD-0.3 (qui est le footprint par défaut) et cliquez ensuite sur 
ADD.  
 

 
Figure 24. 

 
Altium devrait faire apparaitre une fenêtre pour vous demander de confirmer que c’est 
réellement un footprint que vous voulez ajouter. Cliquez sur OK. 

 
Figure 25. 
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Une nouvelle fenetre apparait et celle-ci vous demande quel footprint vous voulez utiliser 
(Figure 26). Évidemment, nous ne connaissons pas par cœur les footprints qui sont 
disponibles. Nous allons donc lui demander de nous les montrer : BROWSE. 

 
Figure 26. 

 
Une autre fenêtre devrait apparaitre (Figure 27). Dans cette fenêtre, cliquez sur le triangle 
en haut à droite pour sélectionner la librairie Miscellaneous.Devices.IntLib [Footprint 
View]. Quand c’est fait, vous devriez voir une liste des footprints disponibles dans cette 
librairie. Selectionnez AXIAL-0.9 et cliquez sur OK.  
 

 
Figure 27. 

 
Pesez encore sur OK pour fermer l’autre fenêtre. Votre condensateur devrait maintenant 
avoir le footprint AXIAL-0.9. 
 
Souvenez-vous bien de ces instructions parce que vous en aurez besoin pour le 
laboratoire 5. 
 
b) Creation d’un footprint 
 
Il arrive parfois que le footprint que vous avez besoin ne se trouve pas dans les librairies 
disponibles. Considérons, par exemple, le commutateur B3F-1052 de Omron illustré à la 
Figure 28. En regardant dans les footprints existants, nous ne trouvons pas le siens. 

 
Figure 28. 
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Pour règler ce problème, il est possible de créer notre propre footprint. Pour ce faire, nous 
allons commencer par se créer une librairie de type PCB : Cliquez sur New → Library → 
PCB Library (Figure 29). 
 

 
Figure 29. 

 
Le but dans la création d’un footprint est d’allouer l’espace necessaire pour chaque 
composante et s’arranger pour que ses pattes puissent être soudées. Pour ce faire, nous 
devons soit prendre les mesures des composantes physiquement ou, la façon privilégiée 
est de se référer à sa fiche technique (datasheet).  
 
Faites une recherche google pour tenter de trouver la fiche technique du commutateur 
B3F-1052 de la compagnie Omron. Lorsque vous aurez trouvé la fiche technique 
cherchez le diagramme mécanique de la pièce. Ce diagramme mécanique contient les 
dimensions qui sont nécessaires pour la création du footprint. 
 
La création du footprint peut se faire manuellement en plaçant les trous, les points de 
soudures et les graphiques interactivement. Ou, lorsque les footprints sont simples, 
comme dans ce cas-ci, le « Component Wizard » d’Altium peut nous faciliter la vie. Pour 
accéder au Wizard, allez dans Tools → Component Wizard. (Figure 30). 
 

 
Figure 30. 

 
 
Une fenêtre d’introduction devrait apparaitre. Pesez sur NEXT. Suite à cette opération, 
une deuxième fenêtre apparaitra (Figure 31). Sur celle-ci, nous allons spécifier le type de 
footprint que nous voulons créer. Heureusement, notre type de footprint (DIP) est 
classique et donc, nous pouvons le choisir dans la liste. En même temps, changez l’unité 
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en bas à droite pour le mettre en métrique. La raison est que la fiche technique s’exprime 
en mm et c’est plus facile quand les unités sont les mêmes. Une fois compété, pesez sur 
NEXT. 
 
 

 
Figure 31. 

 
Dans la prochaine fenêtre, on retrouve un dessin en 3 dimensions consistant de cylindres 
et de cercles (Figure 32). Ce dessin donne la dimension des trous que l’usine doit percer 
pour que nous puissions insérer la composante pour la souder. En regardant la fiche 
technique, il est possible de voir que les pattes ont besoin d’un trou de 1mm. Cependant, 
avec les procédés de fabrication, les trous résultants sont environ 0.25mm plus petits que 
ce qui est indiqué dans le logiciel. Il faut donc changer le diamètre du trou pour indiquer 
1.25mm (1mm pour le trou et 0.25mm pour accommoder le procédé de fabrication). De 
plus, puisque le trou a augmenté de taille, les structures autour des trous doivent aussi 
être grossies : augmentons les tailles à gauche du diagramme pour avoir une valeur de 
2mm. Une fois terminé, on pèse sur NEXT. 
 

 
Figure 32. 

 
La fenêtre qui suit (Figure 33) nous demande l’espace qu’il devrait y avoir entre les 
pattes. Cette information devrait se retrouver dans la fiche technique. 
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Figure 33. 

 
En regardant les dimensions sur le dessin mécanique, on voit qu’il faut changer les 
dimensions : La mesure de 15.2mm devient 6.5mm et la mesure de 2.5mm devient 
4.5mm. Assurez-vous de regarder le dessin et comprendre pourquoi ces chiffres ont été 
choisis. Pesez sur NEXT.  
 
La prochaine fenêtre nous demande l’épaisseur de la ligne utilisée pour dessiner la forme 
de la puce. En temps normal, en faisant des PCBs, on veut ajouter un diagramme pour 
aider au montage final. Dans le cas-ci, nous allons laisser ça tel quel et peser sur NEXT. 
 
La fenêtre suivante nous demande d’indiquer le nombre de pattes sur la puce. Dans notre 
cas, il y en a 4. 
 
Finalement, la dernière fenêtre nous demande le nom que nous voulons lui donner : 
Entrez SWITCH_DIP4. 
 
Nous nous retrouvons avec le dessin de la Figure 34. 

 
Figure 34. 

 
Finalement, nous savons que les commutateurs à bouton poussoir ont souvent 2 pattes 
tandis que notre footprint en a 4 (quel que specifié par le manufacturier). En regardant 
plus en détails dans la fiche technique, nous remarquons que les deux pattes du haut sont  
connectées ensemble à l’interne et que les 2 pattes du bas le sont aussi. Pour utiliser ce 
footprint de 4 pattes avec un symbole à 2 pattes (c’est ce que JE veux.. vous comprendrez 
plus tard), double-cliquez sur la patte 4 et renommez la 1. Double-cliquez sur la patte 3 et 
renommez-la 2. Nous avons donc 2 pattes nommées 1 et 2 pattes nommées 2. 
 
Vous pouvez sauvergarder cette libraire de footprint dans une place sécuritaire. Lorsque 
vous en aurez besoin, vous n’aurez qu’à inclure votre librairie de footprint et associer une 
composante au footprint. 
 
Pour illustrer ce concept, revenons au schéma de tantot et changeons le circuit pour qu’il 
ressemble à la Figure 35 : 
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Figure 35. 

 
 
Il faut ajouter un bouton poussoir (SW-PB) qui se trouve dans la même librairie que les 
éléments que nous utilisons. Double-cliquons sur le commutateur pour changer son 
footprint. Comme tantot, nous allons cliquer sur le footprint existant et ensuite cliquer sur 
ADD. Vous cliquez sur OK pour confirmer que vous voulez ajouter un footprint et la 
fenetre de la Figure 26 apparait. Encore une fois, nous allons selectionner BROWSE, mais 
cette fois-ci, nous savons que notre footprint est dans la librairie que nous venons tout 
juste de créer. Pour s’en servir, il faut lui dire de l’inclure. Pour inclure une librairie, il 
faut cliquer sur les 3 points de suspension (en haut à droite). La fenêtre de la Figure 36 
devrait apparaitre. 

 
Figure 36. 

 
 
Cliquez sur INSTALL et allez chercher la librairie que vous venez de créer. Cette librarie 
devrait apparaitre en bas de la liste. Cliquez sur CLOSE. 
 
Dans la fenêtre, assurez-vous que le nom de la librarie est la vôtre et choisissez le 
footprint que vous venez de créer (un peu comme à la Figure 37). 
 

 
Figure 37. 
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Pesez sur OK quelques fois pour fermer toutes les fenêtres. Votre bouton poussoir est 
maintenant associé au footprint que vous avez créé. 
 
De façon autonome, faites le PCB du circuit que vous avez créé. À la fin, votre dessin 
pourrait ressembler à la Figure 38 : 
 

 
Figure 38. 

 
 
Montrez cette partie au chargé de laboratoire. 
 
Section 3. On met le tout ensemble 
 
Dans la derniere partie, nous allons concevoir un autre système (Figure 39). Ce circuit 
fonctionne en 2 phases : durant la première phase, on charge le condensateur au travers 
du commutateur s1. Dans la deuxième phase on décharge le condensateur au travers de la 
LED par le commutateur s2.  
 

 
Figure 39. 

 
Dessinez le circuit, faites le PCB et montrez le résultat final au charge de laboratoire. 
Utilisez le footprint que vous avez créé pour les commutateurs et utilisez AXIAL-0.9 pour 
le condensateur. 

 

4. Barème 
 
Vous aurez tous vos points si vous avez tout completé et montré au chargé de TD. 
 

 
 
 

d1
LED0

GND

s1

SW-PB

entree

100pF

c1
Cap

s2

SW-PB


